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INSTRUCTIONS FOR SETTING UP A  

CONFLICT SYSTEM IN OUTLOOK 2010 
 

INTRODUCTION 
 

Sole practitioners or small firms can track conflicts in Outlook 2010 using the Contacts 

feature of this program.  Each client/matter is set up as a separate contact card with conflict 

names entered in the Notes field of the contact form.  The Notes field and other fields on the 

contact card can then be searched for names which may pose a conflict.   

 
HOW TO SET UP A BASIC CONFLICT SYSTEM IN OUTLOOK 2010 
 

1. To set up a conflict system in Outlook 2010, begin by creating a new folder in Contacts 

to contain client information.  Launch Outlook.  Click the Contacts button in the 

Navigation Pane on the left side of the screen.  If the Contacts button is not visible, go 

to the bottom of the Navigation Pane, click Configure Buttons , and choose Show 

More Buttons.  You may need to choose Show More Buttons several times to make 

Contacts visible. 

2. Once you are in Contacts, click on the Folder Tab and choose New Folder: 

 

 

 

 

 

3. In the Name: box, type Clients.  Click OK.   
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4. Before entering your first contact, it is recommended that you set up the appropriate 

categories for your conflict system.  Click the Categorize button under the Home tab: 
 
 
 
 
 
 
 
 

 

Choose All Categories...  The Color Categories box will appear: 
 

All categories in Outlook 2010 have a color association.  By default, Outlook offers six 
colors:  Blue, Green, Orange, Purple, Red, and Yellow.  (More are available by clicking 

the Color pull-down menu on the right side of the Color Categories screen.)   
 
The colors in Outlook can be “renamed,” i.e., assigned a name, by clicking in the box 

next to the color and clicking Rename.  The PLF suggests you add Current Client and 
Former Client as two new categories to assist you in tracking conflicts in Outlook 2010. 
 

NOTE:  As an alternative, you can also create two client folders:  Current Clients and 
Former Clients.  If you follow this approach, the Current and Former Client categories 
are not necessary.  Setting up separate Current and Former Client folders will affect 
how you search.  See step 3 in SEARCHING FOR CONFLICTS IN OUTLOOK 2010 
below. 
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5. Set up the category “Current Client” and associate it with the color Blue.  Click in the 

box next to “Blue Category,” click on Rename, type the words “Current Client,” and click 
OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

6. Add the category “Former Client” and associate it with the color Green.  Click in the box 

next to “Green Category,” click on Rename, type the words “Former Client,” and click 
OK. 
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7. You may also wish to add your practice areas and the names or initials of all the 

lawyers in the firm.   
 

For example, if Susan Lawyer and John Attorney had a Domestic Relations and 
Personal Injury practice, their category list might look like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Outlook alphabetizes categories by name.  Using the acronym AOP for Area of Practice 
helps keep Area of Practice categories grouped together.  Current Client, Former 
Client, and the names of the attorneys follow in alphabetical order.  You may need to 
experiment with different naming strategies for categories if you want to keep the 
category list sorted in a particular way.   
 
Now that your category list is set up, you are ready to begin entering client information 
into Outlook 2010. 



© Beverly Michaelis (2011)   Page 5 of 13 

8. Navigate to your Clients folder by using the Navigation Pane.  Click on the Contacts 
button. Next, click on the Clients icon: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

9. To create a new blank contact, click New Contact in the Home tab or use the keyboard 
shortcut <Ctrl> N.   

 
10. A blank contact form will appear: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Begin entering name, address, phone, fax, email, and other details.  Name information 

should be entered by clicking on the Full Name … button.  Address information should 
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be entered by clicking on the Business… or Home …button.  Using these buttons 
ensures that information will be entered in the proper format.  Note that Outlook allows 
multiple address, phone, fax, and e-mail entries.  

 

If the client is a Company, enter the Company name in the Company field on the 

contact card rather than using the Full Name button which is meant to be used when 
entering information pertaining to individuals.   

 
Create a separate contact card for each client or client matter. 

 
11. Use the Categorize button and select the appropriate colors/categories to identify the 

responsible attorney, area of practice, and the client’s status (current client or former 
client).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
12. Enter conflict names in the Notes field (the large blank rectangle at the bottom right of 

the contact card).  List each conflict name separately and indicate the relationship of 
the conflict name to the client.  For example:  ABC Corporation (adverse party); Sue 
Smith (adverse party); All Farm (insurer for ABC Corporation); Roy Jones (lay witness); 
Dr. Samantha Taylor (client’s treating doctor) 

 
Other pertinent case information, such as file number, case description, date opened, 
date closed, etc. can also be included in the Notes field.   
 

To save the contact information, click the Save and Close button. 
 
 
 

Categories 
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Tip: Conflict searches in Outlook will not be reliable unless information is entered in the 
same format consistently.  In the example above, we have suggested “Dr. Samantha 
Taylor” rather than “Samantha Taylor M.D.”  Either will work, but to ensure reliable 
search results, choose one format and stick with it or use a broader approach when 
searching.  For example, to run a conflict search for Dr. Samantha Taylor, search for 
“Taylor” or “Samantha Taylor,” rather than “Dr. Samantha Taylor” or “Samantha Taylor 
M.D.” 
 
Sample Contact Card:   
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13. When a current client becomes a former client, remember to change the client’s 

category in Outlook.  Open the contact, click on the Categorize button, choose All 

Categories…  Click on Current Client to remove the checkbox in that category and click 
on Former Client to activate the former client category.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It is also recommended that you enter the date the client’s file was closed in the Notes 
field, along with the closed file number, if applicable.  You may also wish to update the 
case description. 
 

To save your changes, click the Save and Close button. 
 

NOTE:  If you set up separate Current and Former Client folders instead of using the 
Current and Former Client categories, just move the client’s contact card from Current 
Clients to Former Clients by selecting it with your mouse and dragging it to the Former 
Clients folder.   

 
 
 
SEARCHING FOR CONFLICTS IN OUTLOOK 2010 
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1. To search for conflicts in Outlook 2010, go to your Clients folder in Contacts.  In the 

Search box, type the name or other information you are searching for: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. If a match is found, Outlook will automatically display the card(s) which match the 
search term.  Open each matching card and determine if a conflict exists.  Document 
the results of your conflict search in the client file.  Contact cards can be printed in a 

Memo Style for filing.  In the Outlook ribbon, choose the File tab, then Print, and select 

Memo Style.  To preview before printing from the Print dialog box, select Print Options 
just above Settings.  (Note:  if your office is paperless, select a PDF printer and print the 
Memo to PDF format.) 

 
3. If you created separate Current and Former Client folders in lieu of using the Current 

and Former Client categories, make sure you search All Contact Items when you run a 
conflict check.  By clicking in the Search box, you will automatically activate Outlook’s 
Search Tools.  A Search tab appears with the following choices: 
 

 
 
 
 
 
 
 
 
 
 
 

To search all contact folders, simply click the All Contact Items button. 

Search box 
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In:  file as field only 

In:  frequently-used text fields 

 
4. The steps described above work well for simple conflict searches which generate no 

results or just a few matching cards.   If you find that conflict searches are generating 
multiple matching cards, or if you prefer to print a list of all search results on one page, 
click on Search Tools.   

 
 
 
 
 
 
 
 
 

Then select Advanced Find: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
By default, Outlook 2010 searches only in the “file as” field.  A search of the “file as” 
field will find only a company name or the last name and first name of an individual 
client.  To conduct a thorough conflict search when used Advanced Find, you must tell 
Outlook to look in “frequently-used text fields.”    

 
Change the setting in the drop-down box 
 
to: 



© Beverly Michaelis (2011)   Page 11 of 13 

 
5. You are now ready to search your Clients contact folder for Conflicts.  In the box  

Search for the word(s): type in the name you are searching for.  In the example used 
earlier, Roy Jones was a lay witness in the Betty Client personal injury case against 
ABC Corporation and Sue Smith.  A conflict search for the name Roy Jones would look 
like this: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. To search, click the Find Now button.  If Outlook finds a name, it will generate a list of 
contacts containing that name.  In this case, the contact card for Betty Client comes up: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
7. To determine where Roy Jones is mentioned in Betty Client’s contact card, and what 

connection he has to her case, double-click on Betty’s entry in the search list to view 
her card.   
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8. If a search finds multiple contact cards which include a given name, each contact card 
will need to be opened separately and evaluated for potential conflicts. 

 
9. Avoid the pitfall of searching only for a full name when conducting a conflict check.  If 

Samuel L. Smith is in your system as S. L. Smith, a search using his full name may not 
find the abbreviated entry with his initials.  A quick search under the last name “Smith” 
is better because it generates broader results.  Keep in mind that multiple searches for 
varying formats of a name may also be necessary, especially when looking for a 
corporate entity. 

 
10. For those handling real property transactions, note that address fields can be searched 

as well.  Follow the instructions above to search frequently-used text fields and type in 

the address in the Search for the word(s): box.  For example, a search for the address 
101 SW High Street would find Betty Client’s contact card and would look like this: 
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11. You may also search by tax lot identification number, taxpayer identification number, or 
social security number if that information is entered into the Notes field of your Outlook 
contact cards.  Follow the search steps described above. 

 
12. Remember to reset Outlook to search in Frequently-Used Text Fields each time you 

search.  Every time you click the Find button to do a search, or if you clear your search 

results by clicking the New Search button, Outlook reverts back to its default setting 
and will only look in the “File as” field.  You must change it to look in “frequently-used 
text fields” each time. 
 

13. IF YOUR SEARCH FINDS NO MATCHING CARDS, then the conflict name you 
searched for is not in your system.  You should document this result in the client’s file. 

 


